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Design Tools - Frame View

General
Select
Pan
Zoom Reset
Zoom In
Zoom Into
Calliper
Rotate
Delete
Zoom Out
Zoom Out of

Icon Description

Select Clicking Select allows you to select an object on the Drawing Board.

[E Objects turn red when they are selected. To select more than one object,
press the shift key while you select each object.

Pan ﬂ' Click Pan, and then drag an item across the drawing board to pan from
side to side.

Zoom Reset

Returns you to the view you previously had when the drawing board was
first opened.

Zoom In
This enlarges the visual display of the selected item.

Zoom Into " ]

= Zooms into the currently selected Lite, Face, and Point.

Calliper .-’3"-. The callipers cursor is positioned on the drawing board where you want the
X and Y axis to be situated. The cursor’s distance from the x-axis, distance
from the y-axis and distance from the axis point (i.e. 0, 0) is shown at the
bottom of the dialog box. On the frame drawing board, the callipers allow
you to define and measure distances between objects.

Rotate ﬂiﬁ' Rotates the frame to the orientation you want.

Delete

}( Deletes the item you have selected on the drawing board.

Zoom Out q
This reduces the visual display of the selected item.

|

Zoom Out of O Zooms out of the current view.

Disable Mouse

Dragging ﬁ'
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Design Tools -

Face View
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Section 1 - Wireframe Tab

Merge Lite
Lock / Unlock Points

Section 2 - Resources Tab

Nested Frames
Assembly Substitution
Reverse Assembly
Merge Assemblies
Lites Equal on Height
Add Frame View

Section 3 - Joints Tab

Section 4 - Tools Tab
Thumbnail
Refresh

Section 5 - Wizards Tab

Options Wizard
Assembly Wizard

Grid Frame Wizard
Stepped Frame Wizard
Split Lite Wizard

Horizontal Dimension Wizard
Vertical Dimension Wizard

Section 6 - Macro Tab
Can consist of some or all of these depending on the framing system.
Grid Frame Macro
Door Macro
Fixed Lite Macro
Awning Window Macro
Raked Frame Macro
Angle Trim Macro
Lit by Lite Glazing Macro
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Design Tools — Face View

Section 1 - Wireframe Tab

Merge Lite

Hesnurces] Joints ] T oolz ] Wizards] Sturefruntl Man:n:us] HDDesign] Wi ]
. S iy &

If you require to Merge Lites this can be achieved by the following steps -

B Select the Lites that you want to merge by either selecting them on the
drawing board or under the Objects Tree. (Remembering that if you want to
select more than one lite to hold the Shift Key on your Keyboard).

m (Click on the Wireframe Tab and click on the merge lites button iy .
B This will display the following box asking you which lite you would like to
keep.

®  Once you have selected the Lite you would like to keep then click on the
ol button. This will then merge the Lites.

Documentation Prepared By STA
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Lock and Unlock Points

Fles::uurn:es] Jaints ] Tools ] Wizards] Stu:urefrn:unt] Man:n:us] EDDesign] Wi ]

N ED &

When you are creating a Frame by default the Points are Unlocked. When you lock
Points and Lines these will move as one.

B Drag your mouse over the Lines and Points that you want to lock so these
are highlighted red. (See the following picture).

® Then click on the & button to Lock the points. Or to Unlock the points click
on the @ button.

4000

g5

a0se

g5

B You will notice that we have used the Locked Points to Move a Line which
will become our Transom in this Frame. Therefore the three lines will move

together.

Documentation Prepared By STA
June 2009 S




10 Olympic
'/ GROUP OF COMPANIES

Section 2 - Resources Tab

Nested Frame

Yireframe -J-:uints ] Toolz ] 'W'izards] Stl:urefr-:nnt] Macn:us] EDDesign] st ]
& < @ 5 b

To Nest a frame use following steps -

®m Select the Lite so it is highlighted red. Click on the Resources Tab and click

on the following icon = .

®  This will display a Frame Picker Browser, from here you can select the
frame to nest.

k& Frame Pick |z|@®
Library: 5 h [ Code ]:
ibrary: earch [ Code | -
| <l =] NE
Family 1 2 2 4 A Code Drezcription T |l ok I
All Libraries 400 Centre Glazed
£ Olympic Cancel
+-C1 2430 Series Windows
+-1 2660 Series Centre Glazed
+-2 400 Series Centre Glazed
+- 4450 Senies Double Beaded C Filter...
+-21 450 Seriez Door
+-F1 4500 Series Centre Glazed
+-21 4660 Series Centre Glazed
+-3 Miscellaneous
£ User Libram
A
< > -

m Select from the list then click on the 9% | button.

B This will then display a “Place

................ in Receptor?” box, like the
following.

£ Place 400 in receptor? E|E|E|

Cancel |

m  Select the appropriate receptor and click OK to populate the frame

Documentation Prepared By STA
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Assembly Substitution

-.ll:uints ] Tools ] Wizards] Sturefrnnt] Man:rn:us] SDDesign] Wig ]
7 & * o5 W A tl o

If you require a different Assembly to the one that you first selected you are able to
use the Substitution icon.

m Select the Assembly which you want to Substitute, by selecting it in the
Objects Tree.

m Click on the Resources Tab and click on the 1N button.
®  This will bring up an Assembly Picker Box, select the Assembly you require

and click on the Ok button.

®m  This will then Substitute the Assembly for the one that you have selected.

Assembly Pick
Library: Search [ Code )
| <> = |
Family 123 44 - ok |
=7 All Libraries [filtered) DACO400/0404 M Frame [101.Ex44.4] Heawy

=3 Olpmpic [filtered) | |OACD400/0418 M Frame [101 Bx44 4] Heawy m

-1 400 Series Centre Gla | [0AC0405/05 M Self Mate Mullion Regular = 2 -
=g Hulions | DACO405/29 M Self Mate Mullion Fregular and Fieinforced m
DACO429/29 M Self Mate Mullion Reinforced » 2

0ACO444/0404 14 Frame [101.Ex44.4] Medium
0ACO444/0418 M Framne [101.6x44.4] Medium

n DAC2413/0404 M Frarme [101.6x44.4] Regular

n DAC2419/0418 M Frame [101.Ex44.4] Regular
"??1 T
e £ 4

N Note: If the Assembly that you have selected does not substitute make
sure to check that your joints have remained.
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Reverse Assembly

.Ju:uints ] Tools ] Wizards] Stu:urefn:nnt] Man::rn:us] HDDesign] Wi l
g & 0- 5 o b () RN(AR)

Once you have placed an Assembly onto your frame and if you notice that the
Extrusion you require is on the wrong side you can select Reverse Assembly. This
will reverse the Assembly.

®m Select the Assembly that you want to Reverse, by selecting it in the Objects
Tree.

m (Click on the resources tab then click on the following icon Ik , this will
reverse the Assembly.

designed to orientate the assemblies the correct way around.

NT\ m Note: This should not need to be used as the database has been
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Lites Equal on Width

WireframeJDints ] Toolz ] Wizards] Stu:urefru:unt] Macrus] 3DDE$ign] Wiew ]
@ ix @ - 5 %‘nl T

If you require to make the Lites Equal on Width this is achieved by the following —

m  Select the Lites that you want to make equal, by clicking and selecting them
on your drawing board, remembering to hold the Shift Key on your keyboard
to select more than one.

B (Click on the Resources Tab and then click on the I button.
®  This will then display the following box, asking you to select which Receptor
to use.

V| Receptor to use? Q@f@

Cancel

m  Select the Receptor and press the OK Button.

Note: To achieve equal Glass and Equal Heads and Sills use the Glass or Daylight
Receptor.
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Lites Equal on Height

wireframe Jointz l T oolz ] Wizards] Stl:urefrl:unt] Macrus] SDDesign] Wiew ]
& < & d- o n HI(E)

If you require to make the Lites Equal on Height this is achieved by the following —

®m  Select the Lites that you want to make equal, by clicking and selecting them
on your drawing board, remembering to hold the Shift Key on your keyboard
to select more than one.

m Click on the Resources Tab and then click on the " = button.
®  This will then display the following box, asking you to select which Receptor
to use.

E Receptor to use?

Cancel

®m Select the Receptor and press the OK Button.

m Note: To achieve equal Glass use the Glass or Daylight Receptor.

Documentation Prepared By STA
June 2009 10




0 O lympic
"/ GROUP OF COMPANIES

Add Frame View

‘Wireframe | Resources | Joints ] Toolz ] 'W'izaru:ls] Stnrefn:unt] Man:rn:lsl 3DDesign] WiEny ]

‘ I I =

Frame View is denoted by a graphic of a video camera = .
You must be in Frame View to use this function.

Frame View allows the estimator to capture of snap-shot of the frame at any angle or

view they wish. Simply generate the view or rotation you wish and press the
button. This Frame view taken is added to the Objects tree from where it can be
viewed at any time.

To view a previously saved Frame View —
1. Select the View from the Object tree  2) Right-click and select EDIT

|

Details] Optio s] Eehaviour Desian l Prezentati n] =]u]¥] ] Motes ] ] EadLink]
[\\5 0 Resources lJn:nints ] Tools ] Wizards] Skarefrol
o W x e ! P %
Objects Fg'| | Uze Option: = /Drawmg Eeaid
=1 Frame
- Fages
£ [Face 1
=21 Aftributes RESULT:
=1 pClearence -
Frame View is displayed
=21 Frane Wiews playe

=1 Wiew 417
21 Wiew 41

Ctrl+Enter

Delete Chrl+Del

Open Resource ...,

Frame View snap-shots are also available for use within the Presentation tab.
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Section 3 - Joints Tab

Wireframe] Rezources Tools ] Wizards] Stl:urefr-:untl Macrns] A0Design | Miew
FFrCd PP 4w g4

This function is generally taken care of automatically when the grid frame wizard is
run but can be useful if a joint is not correct.
Instructions below explain how to correct a cut.

® Click on the Joints tab.

®  Make sure you have your Points Displayed on the Drawing Board. Right
Click and go to Display. Make sure the Point has a check next to it.

m  Select one of the Points on the outer Frame. This can be done by either
clicking on the point on the Drawing Board or selecting it in the Objects tree
on the left hand side.

‘uu . . . .
® Click on the " ® button and this will zoom into the point you have selected.
This will then look like the following.

® You now need to select the Extrusion and the Buttline you would like to join.
This is done by holding the Shift Key on your Keyboard and selecting the
two from the Objects Tree on the Left hand side. See the following picture.

Objects F:'E:H Use Optiors =

=1 Azsemblies -~
£ DACZ2401 5 60

&1 SillEl

0aACO400.) 73

DACO400 H 85

0ACO400.) 38

+
o

&
&
£ 0ACO400/0404 M 110
21 0ACO400/0404 M 133
£ 0ACO400/0404 M 156
£ 0AC2401/0404 T 173
1 0ACZ401/0404 T 195
£ 0AC2401/0404 T 211
£ 0ACZ401 5 247
£ 0ACO400H 260

(=3 Head 261
£ DACZ401 5 273
£ DACO400H 236 -

- - -

+-[#

are in Proper Case.
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® The drawing board will then look like the following.

®  You will notice that our Head Extrusion has been selected and our
HEAD/SILL buttline has been selected. We can now join the two.

m Click onthe [B button and this will join the two. Your Drawing Board
should now look like the following.

®  You will notice that the two have joined. You will need to repeat these steps
for all of the Points that you would like to join.
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Section 4 - Tools Tab

Thumbnail

0 Olymnpic
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Wireframel Hesnurces] Joints Wizards] Stu:urefn:unt] Man::rn:us] HDDESign] Wi ]

E@M‘ 0 &g o

B 5 H -

When you create a Frame in the Design View you are able to take a Thumbnail. This
is a picture of your frame that you have created. This picture will then be placed on
your reports. The Thumbnail can be taken either when you are Zoomed Into the
Frame or Zoomed out of the Frame.

You may want certain things not to be displayed when you take a Thumbnail such as
the Points for a neater appearing picture. To do this Right Click on the Drawing
Board and click on Display. The following menu appears.

Edit ...
Delete

Copy

Constraints

Display
Display Cptions

Open Resaurce ...,

CtrHEnter
Ctrl+Del

Chrl+C

Calipers

v Points
Anchor Poinks
v Lines
v Assemblies
v Lights
Light Mames
v Atkachment Bags
Dimensians
v Extrusions
v Surrounding Conditions
v Properties
&rid
Snap ko Grid
Crientation Lines
30 Components
Lineal Components
Perspective
Solid Drawing
Internal EMarks
External EMarks
Annotations
By Quote Groups
User Defined Dimensions

LY

<

v Automated Dimension
Zoomed Out Dimensions
Mested Dimensions

<

User Mested Dimensions
v Glass Codes
IGU Laver Codes
Building Construction Lines
Internal Construction Lines

<

Reference Points

<

Mested Reference Points

<

Reference Poink Marmes
Bubble References
Zoomed Reference Points

From this menu you can select or de-select what you require or don’t require.

Click on the Tools tab and then click on the ' button. You will notice that a
Thumbnail now appears on the bottom Left Hand corner of the quote of that

particular item.
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Refresh
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Wiireframe l Resources ] Jaoints

> e 05 £ ()

Toolz

Wizards] Sturefrnnt] Man::rn:us] EDDesign] Wi l

B E & H -

To Refresh the view within the Design Tab click on the Tools tab and click on the

= , this will refresh the view.
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Section 5 - Wizards Tab

Options Wizard

"-.-'-.-"ireframe] Hesnurces] Joints ] Tools Stu:urefru:unt] Ma-:ru:us] SDDesign] Wiew ]

= %%@w o a4 A B

Here you are able to select Finishes, Glass and change Frame Options.

®m Click on the Wizards Tab then click on the 2 button. This will display the
following screen.
E Option Wizard g|

Quote Options l Frame &ttributes ]

Option Walue | bt |
[=] Ewstrusion Finish Colors Apply
- Finizh MILLT (00) ]
- ExtnFinishCalor2 X
E strFinishColor3 X
- EwtnFinishColord A
. ExtnFinishColors |
[-] Fills
S Windows OECT X
- Lowlite 0ECT ]
- & Doors 0ECT |
- & Commercial Frami... |O0GCT x|
Fills M
- Liners A
- Design Wind Prezzue 1050 Mém2

Help

From within this screen you are also able to change frame options.

m Click on the Frame Attributes Tab. Here it lists all the available
options for that frame.

m (Clicking next to a frame option will bring down a drop down menu
allowing you to select from the choices listed. This can also be done
from within Options/Edit Options Tab.

Option Wizard
Quote Dptiong  Frame Attibutes \

o)
= |/ [

Frame Options

Face 1.5chemal_Height 2750 /Take Care nOt to
Face 1.5chemal _Width 3300 i check/uncheck these boxes
pllearence 5 H N

Internal EMark .

DrefaultFramelimension nput Wireframe |0

Height 2600 v v

Width 4000 v |

Morinal Height 2800 |0

Mominal Width 4000 ||

RightH anding Falze N

C

P A tick in this box will show
Jﬂ [~ Published Options Only onIy the options you can

select
Documentation [ Do | Heb
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Grid Frame Wizard

'W'ireframe] Hesnurces] Joints ] Tools I'W'izards Stnrefrnnt] Macmsl 3DDesign| LUTETEY ]
a2 ane@u o A A,

Each Frame Group within the OLYMPIC database has a DESIGN frame.

IT IS STRONGLY ADVISED that you use this DESIGN frame whenever a special
shape/style is required.

Once you have added your Design Frame (by adding a standard existing frame) to
the Quote it is now time to create the frame using the Grid Frame Wizard. The Grid
Frame Wizard allows you to create a complete frame.

®m Click on the Design Tab from within the Quote - Select the Wizards Tab and
Click on the following icon B , this will then display the following screen.

E Grid Erame Wizard E

Frame Dimensions

Enter the Frame ‘width and Height

Height: 2800
fidth 4000
Shim Spacing

Left: Ii J
Bottom: Ii J
Top: Ii J
Right P ]

Layout
(3“ MHumber of Rows 2
Murnber of Colurans |4

aR

" Light Code 1

[ Create Frame with Equal Lights

Cusztom >
0k | Cancel | Help |
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Enter the Frame Height & Width

Enter in the Height and Width of the frame. (Millimetres)

Layout

Enter in the Number of Rows (i.e. Horizontals) and/or enter in the Number of
Columns (i.e. Verticals).

Lite Code

If the number of rows is to be different for each column, enter a lite code in this field.
Entering a lite code (instead of columns and rows) can create frames that have a
different number of lites in each column. Eg. A lite Code of 213 will draw the following
Wire Frame. i.e. 2 Lites, 1 Lite, 3 Lites.

Create Frame with Equal Lites

Check this box to create equal lites.

m Clicking on the Cystom button will present the following screen.

E Grid Frame Wizard

Frame Dimensions Resource By Layer l Dimensioning | Attachment Bags | Glass | Attibutes
Enter the Frame *#idth and Height Select Layer: |DEFAULT ﬂ
Height: 1000 Agzamblies lJoints ] BOM Adiustments]
“wiidth: 1000 Paozition | Feceptar -
) L=} Whole Frarne
| Duter F
Shim Spacing = EU-T_[efiame
Lele [ | DACIMOD.: Frame (101 6484 “WIREFRAME®
Buottom: J E Fl:ight
Tag li J - DACO400.): Frame (101.6x44.... “WIREFRAME*
- E Head
Fight J | e DACO400 H: Frame [107.6x44... "wIREFRAME®
=} sil
Layout . OAC2401 5: Sill / Transom [1... “WIREFRAME®
. Murnber of Rows 1 [=F Internal
Murnber of Coluring |1 E H:orizontals
: Lo OAC2401/0404 T: Sill / Trams... “WIREFRAME®
OF: =k Yerticals
™ Light Code L DACD400/0404 M: Frame [10... “WIREFRAME®
[=} Comers
i Umrimmnk =l j
[ Create Frame with Equal Lights
‘L Add...

oK. | Cepi] | Help | Restore Entire Frametype|  Selected Tab Defaults |
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This tab allows you to select the Assemblies that are going to be placed onto your
Wireframe. These will be set to defaults but you are able to select others by clicking

on the ™ Button will bring up an Assembly Browser.

Select from the list then click the LI button. Repeat this step until you have
placed Assemblies on all of the Lines.

selected more than one, these can be selected here and then Substituted

K m Note: For internal lines such as Transom and Mullions if you have

at a later stage. Please see steps that follow.

Glass Tab

This tab allows you to select the Glass that you require for the Frame. This can also
be done on the Items/Options Tab, Edit Options.

Grid Frame Wizard

Frame Dimenzions

Enter the Frame *w/idth and Height

Height: 1000
Width: 1000
Shim Spacing

Left: li J
B ottarn: li J
Top: li J
Right: N

Layout

p Mumber of Rows 1

Humber of Colurmnz |1

0oR

" Light Code

[ Create Frame with Equal Lights

(n] 4 | Cancel | Help

=

Resource By La_l,ler] Dimensioning] Attachment Bags l Attributes]

Apply thiz Glazs to the frame (if you change thiz then the quote option will

chahge as well]

Optian YValue | = |

[=] Fills
.. Custom P
- /7 Commercial Framing OECF A
&7 Door Panels 0ECF Fa|
- A7 Windows OBCF P
. Filld x|
- Filla A

Glass To L|s| Commercial Framing ﬂ

Receptor | R ~

Mate: If you choosze custom then you won't able to change the Glass via

quote options for this frame
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Joints Tab
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This tab allows you to set the joints for the Outer Framing. The default joints are the

following.

E Grid Frame Wizard

Frame Dimensions

Enter the Frame ‘Width and Height Select Layer: |{El= g2 ) A
Height 1000 Azzembliez BOM Adustments ]
width: 1000 E IF T

Shim Spacing

Left: ,7 J
B ottarn: ,7 J

Top: J ﬂ
Right J
Layout
& Murnber of B ows ’1—
Number of Calumns |1 H
OR

[~ Force Wireframe to Follaw Assemblies' Jointing

™ Light Code

I~ Create Frame with Equal Lights

Fiesource By Layer l Dimensioning] Attachment Bags] Glazs ] .ﬁ.ttlibutesl

&

i ar

[ o
OF. | Cancel | Help |

Restare Entire Frametype| Selected Tab Defaults |

Hover your mouse on the joint you wish to change and a menu will appear. You can

select a new joint from this menu.

Mane

Corner Mitre

e e e Y e el

Horizonkal Run Through
Wertical Fun Through
Wertical Run Thru to Wireframe

Click on the LI button once you have finished this will then populate your

Wireframe.
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Stepped Frame Wizard

Wireframe] Hesuurceﬂ Joints ] T oolz |Wizards| Sh:urefrn:lnt] Man:rn:ls] 3DDESigﬂl Wigi ]

LiarsBo@eES0I0L. ¥ 0 44 0O

To create a frame with a stepped sill in V6, you must first create a rectangular frame
with all assemblies and fills, and then remove a portion of the frame. The Stepped
Frame Wizard performs the removal.

The Wizard will need a Head or Sill Assembly to be selected in order to complete the
operation. It will remove all the Assemblies on the Head, Sill, left and right Jamb
surrounding the Lite, and split any up if necessary. The first internal horizontal
assembly found will be substituted for the new head or sill assembly.

A step will be created where at least two lites exist, one of top of the other. In the
case where only one lite exists the entire lite including head/sill and fill will be
removed.

V6 will automatically shorten vertical Assemblies — such as Jambs and Mullions, and
will remove Lites and Fills, and place sill assemblies along the new edge and
reconstruct all joints during the process.

® To Step a Frame, Click on the lite so it is highlighted Red

924 52 943 5 945 82 924

051

ooEL

— b

® Click on the Wizards Tab and click on the i button.

This will display the following box — ST X
Side to Step
" Right + Battom
Layer: |DEFALLT |

Agzemblies l Juints ]

| Azsembly |Receptar
([ 70010102 5 = WIREFRAME*
Add Delete
Documentation Prepared By STA ¥
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m (Click OK.

® The lite is now stepped—

224 5 245 e 245 S 224

asel

aocl
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Split Lite Wizard

Wireframel Hesnurces] Jointz ] Tools |Wi23fd3 | Sturefmnt] MEIETCIS] EDDesign] Wig ]
Ll an e Boi@SS0I0L @ 4 4 % O

If you require to Split the Lites this is achieved by the following steps —

B Select the Lite or Lites that you want to Split.

m Click on the Wizards Tab and click on the i button.

®  This will then display the following box-

B split Light Wizard

Light Code:

Reszource by Layer l Receptor ]

Select Layer |DEFAULT |

Azzemblies lJ.:.ints ]

Position | R eceptar
[=} wWhale Frame
El Internal
El Harizontals
e DACZ401/0404 T: Sill / Trans... “wWIREFRAME®
[=} Verticals
: . DACD400/0404 M: Frame [10... “wIREFRAME*
= Cormers
Horizontalz

L Verticals

Add...

Restare Entire Framet_l,lpe| Selected Tab Defaulkz |

] Cancel | Help
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® Enter in a Lite Code.

eg. Entering in a 2 will display the following within a lite -

Entering in 11 will display the following within a lite -

0 Olymnpic
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®m Select the Assemblies that you want to place on the Horizontal and the
Vertical. (These will be set to the default but can be changed here).
B Select the Joints (this will be set to the default).

Note: Using the Split Lite Wizard on this Tab instead of the Split Lite Wizard on the
Wireframe tab will set the Joints for you providing these have been selected.

If there is glass in the lite to be split, the correct receptor needs to be chosen.

B split Light Wizard

Light Code: |2
Resource by Laper

[~ Glass

Fieceptar -

[~ Nested Frame |

Receptor |[EEE -

== | Cuént
/| Current

ak | Cancel Help
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Horizontal Dimension Wizard

Wireframe] Hesnurces] Joints ] Tools Stnrefrnnt] Macrns] SDDesign] Yiew ]
82 a7 muwnaEB0I0l @ 2 1 % 4o

This Wizard allows you to set up a dimension for a Lite. This can be done by the
following steps —

B Select the Lite that you want to place a dimension on.

LI
m Click on the Wizards Tab and click on the ¥—#1button. This will then display
the following screen-

E Horizontal Dimension Wizand @

Enter Dimension between members: |E||:||:|
Distance = 900.00 mm

tember to adjust: " Left f+ Hight
Dirension M arme: |Dimensinn 435
Dimenszion Scheme: |5chema1 ﬂ
Left reference object | Diay Light {r.[1457:700-100 J] ~|
Right reference ohject: |Da_l,l Light [r.1):}45%:700-110411 k]:Left j
Text Placement: |.-’-‘n.bave j
[ Dizplay

Flace Dimension O

{ {s

Conztrain Dimension
f* Mone

™ Fixed

™ Specify

| E

E stension Line

B Length:
Ok, | Cancel | Help |

Enter in the Width that you want to set the Dimension to. (Millimetres).
Select the Line that you would like to move, either Left or Right.

Type in a Name for the Dimension.

Select the Left and Right Reference Objects. This will be Day Lite.

Select whether or not you would like to place a Constraint on the Dimension.
Entering in Minimum & Maximum Values. This will then stop the user from
going below or above these values.

® Or you are able to specify a Formula.
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Vertical Dimension Wizard

Wireframe] Hesnurces] Joinks l Tools |'W'izar|:|s || Sturefrnntl Macrns] 3DDesign] Wi ]
eiane@BongBEI. ¥ e 4 %D

This Wizard allows you to set up a dimension for a Lite. This can be done by the
following steps —

m  Select the Lite that you want to place a dimension on.

B Click on the Wizards Tab and click on the DI button. This will then display

the following screen-
E Vertical Dimension Wizard g

Enter Dimension between members: |.'-"DD
Distance = F00.00 mm

Member to adjust: " Top + BUNU'T‘
Dimenszion Mame: |Dimensi0n 436
Dimenzion 5cheme: | Schemal ﬂ
Top reference ohject; | Day Light (11457:700-100 H] |
Bottom reference object: |Day Light [r.)[A5Y: 70010302 T].Top ﬂ
Text Flacement: |.t'-\bove j
[~ Display

Flace Dimenzsion On:

i {+

Caonstrain Dimengion
(* Mone

" Fized

poo " Meimm oo

" Specify

| B

Extenszion Line

- Length:
QK | Cancel ‘ Help |

Enter in the Height that you want to set the Dimension to. (Millimetres).
Select the Line that you would like to move, either Top or Bottom.

Type in a Name for the Dimension.

Select the Top and Bottom Reference Objects. This will be Day Light.
Select whether or not you would like to place a Constraint on the Dimension.
Entering in Minimum & Maximum Values. This will then stop the user from
going below or above these values.

® Or you are able to specify a Formula.

origin (i.e. the dotted line on your drawing board). Make sure you select the correct
line to move so that you frame does not move off this origin point.
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Section 6 - Macro Tab

Grid Frame MACRO

Wireframe] Hesnurces] Joints ] Tools ] Wizards] Starefront A0 Deszsign | Wiew

Oal=lN~"E

The Grid Frame Macro provides the same functions as the Grid Frame Wizard that
we looked at earlier on the Wizards tab.

Door MACRO

OLYMPIC have created a series of Door Macros within their relevant frames to
automate this process and ensure no steps are ‘missed’ by operators.

These can be accessed via the Macro Tab —

There is a choice of Hinged and Sliding doors.
Wireframe] Hesnurces] Joints ] Toals ] Wizards] Starefront l 3DDesign] Wiew ]

EQQl- s

Instructions for use of these Macros is explained in the Design Trainer Manual —
Pages 11 & 12

Fixed Lite MACRO

Wireframe] Hesnurces] Jointz | Tools ] Wizards] Starefront l EDDesign] Wiew ]

I E-0-0

This Macro places a fixed lite in any selected frame.
Eg: You can use this macro to change a door back to a fixed lite in 1 easy step.

o

74 % " v v
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Awning Window MACRO

Wireframe] Hesnurces] Jointz ] Tools ] Wizards] Staorefront ] EDDesign] Wiew ]

EO@e--@E=

Insert an Awning Window into your frame by following these steps-

m  Select the lite that you want to use by clicking it so it turns Red
m (Click on the Awning Window Macro icon

®m  Select your window options

B Add 2430 Sash E'
Sazh Optionz
Sash Group OAC2430
Sash Stop |DACD425 =
r B

Joint Tepe for Stops
{+ Mitre Joint " Butt Joint

Hardware Optionz

Spigot DAC2434 -l

O lywrmmpic L
" GROUP OF COMPANIES  Cancel

m Click OK one you have finished to place the awning window into the frame
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Sub Head / Sub Sill & Jamb Placement Macro

Wireframe] Hesnurces] Jaintz ] Tools ] Wizards] Starefront 3DDesign] Wiew ]

EOOE-EES

m  Select the lite to insert the sub head, sill or jamb into by clicking it so it turns

Red.

—

Whifeq
g5/ 1

da4

=[]

14 33

Daylight

Daylight " Daylight

® (Click on the Sub Head/Sill Macro icon

®m Select placement options & click OK to populate the frame

I Subs
Sub Head, Jamb and Sill Options

3

Sub Head

|N|:|t Required

| 0ACO436 (Head Channel (11006 3 50

0AC0412 (Head Channel [11006 = 40])
0ACD428/89 [Beaded Sub Head Heawy]

0ACD493/551 [Beaded Sub Head Heawy]

Sub Jamb [R] | Mat Fequired

Qwer Run

Cancel
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